Technical Information

NPX™ Signature Software
version 1.xvs 2.0

User Interface

The Ul is harmonized with NPX™ Map (successor of NPX™ Explore software).
The new Ul is more intuitive and user friendly.

Projects

= Nlink:
L | RSN ]AN

Summary NPX™ Signature v 1.x NPX™ Signature v2.0
Terminology  Study e Project
change « Flagged « Warned
e Table view e Workspace view
* Assay QCview » Plate Data view
e Z-Score * Plate Variation
» Sample Type » Sample Matrix (urine, plasma, etc)
* Sample Type » Sample Type (Sample, External Control)
¢ Plate Name ¢ Run Name
File Format « Studies saved as single .npx files.  Projects are stored as folders including a project
file with the extension .osp (Olink® Signature
Project).
Compatibility « .npx study files can be opened.  .0sp project files can be opened
« .oaf (Olink® NPX Manager project file) can be « Studies created in NPX Signature 1.x, can be
opened in NPX™ Signature vl.x and saved as a migrated in NPX Signature v2.0 ensuring a
.npx file. smooth transition. During migration a copy will
« .0sp project files created in NPX™ Signature v2.0 be created and saved as an .osp project file. The
cannot be opened. original .npx or .oaf file is unchanged.
Notes The user can enter internal notes on project and The user can enter internal notes on project and
plate level. plate level. Plate Notes can be entered in Plate
Details view only.




Panel Data File and Archive

Summary

NPX™ Signature v 1.x

NPX™ Signature v2.0

Olink® Target
Panel Data Archive
concept

All Olink® Target 48 and Olink® Target 96 panel
data files are integrated into the software. In order
to analyze data from a newly released kit reagent
lot, a new software version must be installed.

The Olink® Target Panel Data Archive cannot be
imported in NPX Signature v1.x.

Olink® Target Panel data files are not integrated in
the software. An Olink® Target Panel Data Archive
must be imported in NPX™ Signature 2.0 before
any Olink® Target 48 or Olink® Target 96 data can
be analyzed. In order to analyze data from a newly
released kit reagent lot, an updated Olink® Target
Panel Data Archive needs to be imported into the
software. This archive will encompass all Panel Data
Files for both Olink® Target 48 and Olink® Target
96.

The Panel Data Archive is an encrypted .dat file.
It is compatible exclusively with NPX™ Signature
v2.0 and cannot be used with NPX™ Signature v1.x.

Panel Data Files
for Olink® Flex and

For Olink® Flex and Olink® Focus panels, the format
of the Panel Data File must be format NPXSv1.

For Olink® Flex and Olink® Focus panels, the Panel
Data File will have the suffix _NPXSv2.

Olink® Focus
Reagent Lot In order to analyze data from a newly released During a reagent lot release for Olink® Target 96 or
releases reagent lot, a new software version must be Olink® Target 48, a new Panel Data Archive file will

installed.

be issued. This file will include all previous panel
data files along with the newly added panel data
file.




Sample Manifest

Summary

NPX™ Signature v 1.x

NPX™ Signature v2.0

Template

A generic template is available via the Plate
Manifests page.

A product-specific template is available in the main
application under Project -> Sample Manifest.
Product-specific templates are also available from
the Project Creation Workflow.

Requirement

The Sample Manifest is optional, and is not needed
when run data is annotated with SamplelD. The
Sample Type is automatically inferred by the
software based on SamplelD. Incorrect automatic
annotation must be manually corrected in the Plate
Layout view.

The Sample type can be assigned in the Plate
Layout view manually.

The Sample Manifest is mandatory for all plates and
must include Sample Type annotation per well.

The Sample Types can only be set via the Sample
Manifest. To change Sample Types, the Sample
Manifest can be replaced via Plate Details view.
There is no need to re-import the run data.

Sample Type The Sample Manifest did not include Sample Type. | The Sample Manifest now includes a new required
column: Sample Type.
Sample Type is based on the Sample ID. The Sample
Type can be changed in the user interface.
Sample ID No restrictions when importing the manifest. Maximum 100 characters, allowed characters are:
Character “” (period) resulted in errors in the user o A-Z
interface. . -7
* 09
o #
 space
Plate ID The Plate ID which is included in the data export The Plate ID which is included in the data export
file is either the run name in the raw data file or set | file can only be set in the Sample Manifest.
via the user interface.
Duplicates Duplicates are allowed. All sample IDs within a single Sample Manifest

must be unique. Sample IDs can be changed by
replacing the Sample Manifest for the run.

Anonymization

It is possible to anonymize a study.

It is possible to create an anonymized copy of a
project.

Run file

Summary

NPX™ Signature v 1.x

NPX™ Signature v2.0

Run Data location

Data can be imported directly from an Olink®
Signature Q100 instrument with enabled remote
connectivity.

Data cannot be imported directly from an Olink®
Signature Q100 instrument.




QC and Normalization

NPX™ Signature v2.0

Possible Manual QC:
— Manual sample fail

— Manual assay fail
— Manual datapoint fail

Summary
Manual QC

NPX™ Signature v 1.x

Possible Manual QC:
— Manual sample fail

— Manual assay fail

— Manual datapoint fail

Effects of manual QC emulates automatic QC:
e.g. manual sample fail is equivalent to automatic
sample fail.

During migration, if all datapoints in an assay were
individually manually failed in NPX Signature v1.x,
NPX Signature v2.0 will treat the assay as manually

failed.

Pre-Normalization
adjustments

e Background cap applied to all sample types
in Olink® Target 48, Olink® Flex, and Olink®
Focus, meaning that all measurements undergo
a background correction to limit non-specific,
irrelevant signals that may interfere with the
accurate measurement of the intended target.
In customer samples this might artificially mask
actual variation with the risk of false positive
associations.

 Background cap is not applied for Olink® Target
96.

¢ Detect line-in-chip: =5 assays with no detectable
signal (used for all Sample Types including
Negative Controls). All data for sample is
considered failed.

Background cap applied only to Negative
controls in Olink® Target 48, Olink® Flex and
Olink® Focus. Customer samples with very low
signal (Ct =24) will have different NPX and
Quantified value in NPX Signature vl.x and v2.0,
due to the actual Ct value not being replaced
with Ct 24.

No change for Olink® Target 96 (Background cap
is still not applied for Olink® Target 96, due to
different chemistry).

Detect line-in-chip: =5 datapoints within an assay
that are manually failed or with no detectable
signal (not used in Negative Control). All data
for sample is considered failed. No normalization
possible, Sample QC set to Fail.

Normalization

e Ctvalues are rounded to 5 decimals prior to
normalization.

No rounding of Ct-values. Using full precision
from input data can lead to small numeric
differences.

Calibrator / IPC Normalization calculation stays
as before.

Olink® Target 96
Intensity
Normalization

« Intensity normalization is done differently
compared to Olink® Explore 3072, Olink® Explore
HT, and Olink® Reveal.

« Intensity normalized NPX changes when plates
are added or removed from the project.

* Median NPX across all plates is used as the
reference value during Intensity normalization.

Intensity normalization is done in the same way
as for Olink® Target 96 as for Olink® Explore 3072,
Olink® Explore HT, and Olink® Reveal.

Intensity normalized NPX is unchanged when
plates are added or removed from the project.

0 (zero) is used as the reference value during
Intensity normalization.

Intensity normalized NPX values are different
compared to NPX Signature v1.x, however, there
will be no changes to statistical results.

Data

NPX data above ULOQ and below LLOQ will be

NPX and Absolute quantification (pg/ml) data

provided and included in the data export. above ULOQ and below LLOQ will be provided and
included in the data export with the information
that the data is above ULOQ / below LLOQ in extra

columns.




Summary

NPX™ Signature v 1.x

NPX™ Signature v2.0

Sample QC « In Olink® Target 96 all samples are QC:ed relative | ¢ In Olink® Target 96 external controls and regular
to internal control assay medians calculated samples are QC:ed relative to internal control
based on all sample types. This can cause false assay medians calculated separately for the two
QC failure for external controls when the regular groups. This removes the risk for false QC failure
samples are from a different sample matrix such for external controls when the regular samples
as CSF or urine. are from a different sample matrix such as CSF or

¢ In Olink® Target 96 Incubation Control 2 is used. urine.

« Olink® Focus calculates separate plate medians * Incubation Control 1 is used in Olink® Target 96
for customer samples and sample controls vs. which is the same antigen as the only Incubation
negative controls and calibrators. Control in other products. Olink® Focus calculates

separate plate medians for customer samples
and external controls, where external controls
are sample controls, negative controls and
calibrators.

Assay QC Assay QC warning criteria: Assay QC warning criteria:

» Sample Control precision (%CV), Calibrator/IPC
precision (%CV):

— is calculated based on absolute quantification.
(Exception: Sample Control precision not used for QC
for Olink® Target 96).

» Sample Control Accuracy (for panels with

absolute quantification only):

— Absolute quantification data (pg/ml) including above/
below LOQ used. Mean as point estimate, which may
be sensitive to extreme outlier values.

— Less than two sample controls above LQL and below
ULOQ. Less than two calibrators above LQL and below
uLoQ.

Assay QC fail criteria:
e Minimum 2 Sample Control replicates with
Sample QC “Pass” and no instrument warning.

« Inter-Plate Control replicated. No Negative
Control ctrlin QC for 1.x.

For Olink® Target 96: no automatic Assay QC checks

» Sample Control precision (%CV), Calibrator/IPC
precision (%CV):

— is calculated based on NPX. (Exception: Sample Control
precision not used for QC for Olink® Target 96).

» Sample Control Accuracy (for panels with

absolute quantification only):

— Absolute quantification data (pg/ml) including above/
below LOQ used. Median as point estimate, which is
less sensitive to outliers.

Assay QC fail criteria:

e Minimum 2 valid (Sample QC “Pass” and no
instrument warning) Calibrator / IPC replicates.

e Minimum 2 Sample Control replicates with
Sample QC “Pass” and no instrument warning.

e Minimum 2 Negative Control replicates with
Sample QC “Pass”.

For failed assays only Ct values will be provided.

For Olink® Target 96: New Assay QC check based on
precision (%CV) of Interplate Controls.




Summary

NPX™ Signature v 1.x

NPX™ Signature v2.0

Run QC

Run QC warning criteria:

Information is displayed under Panel Metrics
Variation in internal controls: Standard deviation
uses NPX values and is calculated for customer
samples and external controls, is calculated

for the same sample groups as Assay QC. The
standard deviation is sensitive to extreme
outliers.

Definition of the thresholds for the number of
non-passing samples varies between panels.
Above 5 (Olink® Target 48)/ 3 (Olink® Flex)
assays with too few sample control or calibrator
replicates within LOQ.

Minimum 1 Sample Control replicates (Only used
in products that are sold with Sample Controls,
not used for Olink® Target 96) with Sample QC
“Pass”.

Minimum 1 Negative Control replicates with
Sample QC “Pass”, else error with import.

No minimum defined for Calibrator / IPC
replicates with Sample QC “Pass” for Olink®
Target 48 and Olink® Target 96.

Minimum 2 Calibrator replicates (for each
Calibrator type) with Sample QC “Pass” for Olink
Focus.

Run QC warning criteria:

Information is displayed on new view Project
Metrics.

Variation in internal controls: Median absolute
deviation uses NPX values and is calculated for
separate groups; customer samples vs. external
controls. The median absolute deviation is less
sensitive to outliers than standard deviation.
Definition of the thresholds for the number of
non-passing samples varies between panels.
Number of warned or failed customer samples is
more than 1/6.

Number of warned or failed assays (not INC, EXT,
AMP) above 1/9.

Minimum 2 Sample Control replicates (Only used
in products that are sold with Sample Controls,
not used for T96) with Sample QC “Pass”
Minimum 2 Negative Control replicates with
Sample QC “Pass”.

Minimum 2 Calibrator / IPC replicates with
Sample QC “Pass”.

Project Metrics

%CV (Inter) displayed under Panel Metrics is
calculated as the total variability of all Sample
Controls on all plates. This is not according to
common practice in the scientific community.
Range of internal control Ct values is not
presented.

Inter-plate CV displayed on Project Metrics is
calculated as the variability across plates of the
typical Sample Control value. This is according to
common practice in the scientific community.

Range of internal control Ct values
Only data from customer samples is considered.

Bimodal assays

Olink® Target 96 assays TDGF1 in panel Neuro
Exploratory are handled as bimodal, meaning that
IPC normalization is applied even in studies where
Intensity normalization has been selected on a
study level.

No assay is set as bimodal by default. It is
recommended to define in the Plate Variation view
if an assay has a bimodal profile. In this case the
extended data export will provide both the Intensity
normalized (NPX) and IPC normalized NPX values
in one file.




Data output

Summary

Export file

NPX™ Signature v 1.x

Data Export file format:
— Xxlsx

- .Csv

Layout:
— Wide format

- Long format

Columns:
— Asubset of the NPXS v2.x columns.

A new export file/ three separate files are required
for exporting Ct, NPX and Quantified values is
required.

NPX™ Signature v2.0

Data Export file format:
— sV

Layout:
— Long format

Two variants of the data export file are available:
standard and extended. Both variants are presented
in a long format only (text based and semi-colon

separated columns) and provide:
— Ctdata

- NPX data
— Quantified data (for absolute quantification panels)

All numeric values are presented with five decimals.
Please note that due to increased precision in
intermediate calculations in the software, the

NPX and Quantified values are expected to differ
between NPX Signature v1.x and v2.0. This will not
impact the biological relevance of the data.

Additional columns are included:

— The Sample Type is indicated in a separate column,
allowing for easy separation between external controls
and samples.

— The Limit of Detection (LOD) is included in the data
export file, and a separate column indicates whether
each datapoint is above or below LOD.

Analysis Report

Customized company name & logo can be added
via Settings -> Analysis Report Configuration.

The procedure for including a customized company
name & logo in the Analysis Report has changed.
For detailed instructions on how to implement the
logo, please refer to the NPX™ Signature Software
User Manual.
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